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Selecting a Translator
Any operation that is associated with a specific translation direction requires that you select 
a Source/Target Language Pair.    When translating, the Source/Target Language Pair 
indicates the direction you wish to translate. 
· The Source is the language you wish to translate from. 
· The Target is the language you wish to translate to. 
For example, if you wish to translate English to Spanish, English is the Source and Spanish is 
the Target. 
When working with the dictionaries or setting options, the Source/Target Language Pair 
identifies the appropriate files to be modified. For example, if you wish to add an English 
word with a corresponding Spanish translation, English is the Source and Spanish is the 
Target.
To select a Source/Target Language Pair, click on the pair you wish to choose and click on 
OK.



Opening External Documents
Globalink Power Translator Pro supports the following formats:

· Microsoft Write
· Hypertext Markup Language (HTM, HTML)
· Rich Text Format (RTF)
· Text
· Microsoft Word 2.0 for Windows
· Microsoft Word 6.0 for Windows and Windows NT
· Microsoft WordPad (saved in Text or RTF formats)

If your word processor is not among those listed, you can save your file as RTF, text, or copy 
your text to the Windows clipboard and paste it directly into a blank Globalink Power 
Translator Pro Project. Refer to your word processor’s manual for specific instructions on 
saving a file with a different format.
When you use Globalink Power Translator Pro to open a word processing file, the program 
creates a new, unnamed Project File and places a copy of the text from the word processing 
file into the new project. You are NOT directly editing or changing your original word 
processor file. 
Globalink Power Translator Pro does retain the format from your word processor. You may not
see all of the formatting from the original file, but once you have completed and saved the 
translation, you will be able to open the translated file in your word processor and see the 
original formatting.
To import a word processor file, select Open from the File menu. The Open window will 
appear. To open your word processor file, you must first specify the file type in the List Files 
of Type box. Click on the down arrow on the right-hand side of the List Files of Type drop-
down box to display the file formats supported by Globalink Power Translator Pro. Select the 
appropriate file type in the list by clicking on it with your mouse. Once you have selected the
file type, locate your file as you normally would and click on OK. 
Since Globalink Power Translator Pro needs to know the source and target languages for this 
new project, the Select a Source/Target Language Pair window will appear. Select the 
appropriate pair and click on OK. A copy of your word processor file will appear in an untitled
project window. Or, after selecting the correct Source/Target Language Pair, click on the 
Quick Translate button to create the new project and immediately begin automatically 
translating the document.
Remember, what you see on your screen is not your original document. What you see on 
your upper screen is a copy that Globalink Power Translator Pro uses to create the 
translation. What you will see on the lower half of the screen is the translation that you can 
save in the format of your word processor.



Searching For Text Within A Document
To search for a particular text string within a document, select Find from the Edit menu. After
you click on Find, the Find dialog box will appear. Type the text string you wish to find in the 
Find What box. The following options are available in the Find dialog box:
Search      The Search box allows you to select if you want to search up or down from the 
current cursor location. 
Search Within Selection Only      If you have highlighted certain text, and only wish to 
search that selection, click on the Search Within Selection Only box. 
Match Case      Click on the Match Case box if you want to search only for strings with the 
capitalization you have entered. 
Find Whole Words Only      Click on the Find Whole Words Only box if the word you entered
is a stand alone word and not part of another word. For example, if you are searching for cat,
you don’t want the search to find words such as indicate.



Replacing Text Within A Document
To replace text within a document, select Replace from the Edit menu. After you click on 
Replace, the Replace dialog box will appear. Enter the text you wish to replace in the Find 
What box. Enter the replacement text in the Replace With box. The following options are 
available in the Replace dialog box:
Search      The Search box allows you to select if you want to search up or down from the 
current cursor location. 
Search Within Selection Only      If you have highlighted certain text, and only wish to 
search that selection, click on the Search Within Selection Only box. 
Match Case      Click on the Match Case box if you want to search only for strings with the 
capitalization you have entered. 
Find Whole Words Only      Click on the Find Whole Words Only box if the word you entered
is a stand alone word and not part of another word.



Selecting Sentences
To select a sentence within your document, choose Select Sentence from Globalink Power 
Translator Pro’s Edit menu. When you click on this command, a submenu will appear 
allowing you to select one of the following:
By Number      Clicking on By Number will bring up the Go To Sentence dialog box. Enter the
number of the sentence you wish to go to. You can find sentence numbers on line-by-line 
printouts.
First      Highlights the first sentence in your project.
Previous      Highlights the sentence previous to the cursor location or currently highlighted 
sentence.
Current      Highlights the current sentence.
Next      Highlights the next sentence from the cursor location or currently highlighted 
sentence.
Last      Highlights the last sentence in your project.
You can also use various Globalink Power Translator Pro Speed Bar buttons to select 
sentences. See the User’s Guide for complete information on the Globalink Power Translator 
Pro Speed Bar.



Looking Up Words In A Dictionary
To access Globalink Power Translator Pro’s dictionaries, follow these steps:
1. Click on Dictionaries in the Tools menu. The Select Translator dialog box will appear.
2. Select the Source/Target Language Pair for the dictionary you wish to view. The 
Source/Target Language Pairs that you have available depends on the languages that you 
have installed. The dictionary that you have selected will appear.
Note: For information on editing, rather than viewing, dictionaries, refer to Adding New 
Dictionary Entries or Editing Existing Dictionary Entries. Looking up words in the bilingual 
dictionaries is not the same as searching for entries in the dictionary maintenance screen.
When the dictionary window is displayed on your screen, follow these steps to look up a 
word:
1. Make sure that the Dictionary Search button is depressed, which displays the Search and 
Root Words boxes at the top of the dictionary display.
2. Click in the Search box and type the word you wish to find. The dictionary will display the 
selected word (or its root word if you are searching for an inflected word).
3. The first possible translation will be highlighted. In most cases, the first entry is the one 
most commonly used. To select another entry, click on that entry. To copy a translation to 
the clipboard, click on the Copy to Clipboard button.
4. Click on the Inflect Word button to display the various inflected forms of the word, if any. 
The inflections window allows you to select the tense or case that you wish to view.
5. To look up the translation of a single word from within a project, place your cursor in or 
highlight the word you wish to look up and select Look Up Word (or press Ctrl-R) from the 
Translate menu. The dictionary window will appear with the translations for that word.



Adding New Dictionary Entries
Adding to and editing the dictionaries are very similar procedures. The general procedure is 
as follows: 
1. Add a new headword (or edit an existing headword).
2. Select the dictionary to which you want to add the word.
3. Designate a part of speech.
4. Verify, and change if needed, the inflections pattern used to determine how the new 
headword is inflected.
5. Provide a translation (and comments, if desired).
6. Assign attributes, where applicable.
7. Add additional translations and parts of speech for the headword, if necessary.
These steps are explained below.
Add a New Headword
To add a new word, click on the Add Word button. You will be presented with a blank Edit 
Dictionary Window.
Type the new headword in the headword box (to the right of the yellow square). Headwords 
should be entered in their uninflected form. Note that each headword MUST consist of a 
single word only. Phrases, consisting of two or more words, must be added to the entry for a 
single headword.
Select the Dictionary
The next step is to select the dictionary to which you would like to add the word. The Select 
Dictionary field is to the right of the Headword box. Click on the down arrow attached to the 
Select Dictionary box to view a list of the active dictionaries and highlight your choice to 
select the desired dictionary.
Selecting a Part of Speech
The next step is to select the correct part of speech. First, click on the blue diamond    below 
the headword you have entered to switch to the Part-of-Speech section. Then, click on the 
arrow button to the right of the part of speech field. A list of the available parts of speech 
will appear. Click on the correct part of speech for the word. The part of speech will 
automatically appear in the text box.
If you are adding a noun to a foreign to English dictionary (e.g. Spanish-English), you must 
designate the gender of the foreign noun. To do so, click on the down arrow attached to the 
Gender field, to the right of the part of speech you have selected. Selecting a gender marks 
that entry with the appropriate gender attribute. 
Assigning Inflections Patterns
After selecting a part of speech, you must select an inflections pattern. Globalink Power 
Translator Pro uses inflections pattern to determine how the new headword is inflected or 
conjugated. Words are inflected to denote case, gender, number, tense, and comparison.
Globalink Power Translator Pro will automatically assign an inflections pattern. While the 
program typically makes very accurate assignments, you will need to review or change the 
inflections pattern Globalink Power Translator Pro has assigned to the new word. To review 
and/or change the inflections pattern, click on the Morphology button located to the right of 
the part of speech selection (or press F5). The Specify Inflections dialog box will appear, 
listing the possible inflections models on the left-hand side.
To select an inflections pattern, move the highlight bar to any of the available choices. As 
you move your highlight bar to the different choices, different inflections will appear on the 
right hand side of the Specify Inflections dialog box. Choose the inflection model that 
produces the most accurate inflections set. Click on OK.
Provide a Translation



Enter the appropriate translation(s) for your headword. First, move the highlight bar to the 
line below the part of speech indicator by clicking your mouse pointer on the red dot. 
Only one translation should be entered on each line. Comments should be placed in 
parentheses following the translation. 
Attributes
Many of the rules Globalink Power Translator Pro uses when translating take advantage of 
attributes that have been assigned to words. Attributes help define a dictionary entry’s 
semantic (meaning) and syntactic (structural) usage in a sentence, beyond simply selecting 
a part of speech and morphology code. For example, the English word teacher is not only a 
noun, but an animate noun as well as an occupation. Selecting the Animate and Occupation 
attributes for the word teacher ensures that the correct rules are used to create the best 
possible translation. Therefore, it is strongly recommended that you assign attributes where 
appropriate in your dictionary entries.
Attributes can be assigned to part of speech sections (designated with blue diamonds) or to 
translation lines (designated with red circles). When you assign an attribute to a section, you
are assigning it to every line within that section. 
The list of attributes for any part of speech can be accessed by clicking on the Attributes 
button, or by pressing F6. The Attributes dialog box will appear. Some parts of speech, such 
as Suffix, have no possible attributes.
If you activate the Attributes dialog box while on a Part-of-Speech section, you will display a 
variation of the dialog box that includes attributes that vary within the section. 
Entries may have more than one attribute. For example, the English word "programmer" 
may have Animate, Human, and Occupation noun attributes. 
To select an attribute, follow these steps (for explanations of the available attributes, please 
refer to the Globalink Power Translator Pro User’s Guide):
1. Place the cursor in the box for the appropriate attribute. Click to place an X in the box.
To remove an attribute, click again in the box for the attribute you wish to remove.
2. When you have selected all the attributes required for the current definition, click on OK 
to save the choices.
Once you have completed these steps, you can add additional translation lines or part-of-
speech sections by clicking on the appropriate buttons.



Editing Existing Dictionary Entries
To edit an existing dictionary entry, follow these steps:
1. Search for the word you wish to find by entering the word in the Search text box.
2. Make sure that the Dictionary Edit button is depressed, which places the dictionary in edit 
mode.
3. If you would like to change the translations of a headword, add new translations, or add a 
different part-of-speech, please refer to the help section Adding New Words to the 
Dictionaries.
4. Make any desired changes to the word, including;
Specifying Attributes
Specifying Inflections 
Specifying the Inflection Boundary of German Nouns 



Specifying Inflections
After selecting a part of speech, you must select an inflections pattern. Globalink Power 
Translator Pro uses inflections pattern to determine how the new headword is inflected or 
conjugated. Words are inflected to denote case, gender, number, tense, and comparison.
Globalink Power Translator Pro will automatically assign an inflections pattern. While the 
program typically makes very accurate assignments, you will need to review or change the 
inflections pattern Globalink Power Translator Pro has assigned to the new word.
To review and/or change the inflections pattern, click on the Morphology button located to 
the right of the part of speech selection (or press F5). The Specify Inflections dialog box will 
appear, listing the possible inflections models on the left-hand side.
To select an inflections pattern, move the highlight bar to any of the available choices. As 
you move your highlight bar to the different choices, different inflections will appear on the 
right hand side of the Specify Inflections dialog box. Choose the inflection model that 
produces the most accurate inflections set. Click on OK.
When specifying inflections for German nouns, you will be able to designate the Inflection 
Boundary.
When specifying inflections for German verbs, you will be able to designate the Separable 
Prefix as well as the Past Participle Inflection.



Specifying Attributes
Many of the rules Globalink Power Translator Pro uses when translating take advantage of 
attributes that have been assigned to words. Attributes help define a dictionary entry’s 
semantic (meaning) and syntactic (structural) usage in a sentence, beyond simply selecting 
a part of speech and Inflections Pattern. For example, the English word teacher is not only a 
noun, but an animate noun as well as an occupation. Selecting the Animate and Occupation 
attributes for the word teacher ensures that the correct rules are used to create the best 
possible translation. Therefore, it is strongly recommended that you assign attributes where 
appropriate in your dictionary entries.
Attributes can be assigned to part of speech sections (designated with blue diamonds) or to 
translation lines (designated with red circles). When you assign an attribute to a section, you
are assigning it to every line within that section. 
The list of attributes for any part of speech can be accessed by clicking on the Attributes 
button, or by pressing F6. The Attributes dialog box will appear. Some parts of speech, such 
as Preposition, have no possible attributes.
If you activate the Attributes dialog box while on a Part-of-Speech section, you will display a 
variation of the dialog box that includes attributes that vary within the section. 
Entries may have more than one attribute. For example, the English word "programmer" 
may have Animate, Human, and Occupation noun attributes. 
To select an attribute, follow these steps:
1. Place the cursor in the box for the appropriate attribute. Click to place an X in the box.
To remove an attribute, click again in the box for the attribute you wish to remove.
2. When you have selected all the attributes required for the current definition, click on OK 
to save the choices.



Specifying The Inflection Boundary for German Nouns
The following Help Topic only applies to users of Globalink Power Translator Pro 
German.
When adding a German noun that takes an umlaut when pluralized, you must choose the 
portion of the noun    that needs to be inflected (known as setting the inflection boundary). 
This applies only when the Inflection Pattern that you have selected specifies that the noun 
takes an umlaut in the plural form (e.g., -es/"-e).
By default, the program will add the umlaut to the first vowel that can take an umlaut, 
starting from the left. To specify a different vowel, you must mark the correct portion of the 
noun in the Inflection Boundary portion of the Specify Inflections window. 
To specify the inflection boundary, use your mouse cursor or the arrow buttons to change 
the highlighted portion of the noun in the Inflection Boundary portion of the Specify 
Inflections dialog box. The program will add the umlaut to the first vowel that can take an 
umlaut to the right of the left edge of the highlighted portion of the noun. As you move the 
highlight bar, you will see the changes displayed in the examples portion of the window. 
When you have selected the correct inflection boundary, click on OK.
For example, the German noun Bademantel (bathrobe) becomes Bademäntel in the plural. 
Assigning mantel as the Inflection Boundary ensures that the correct vowel will take the 
umlaut when the word is pluralized.



Separable German Verbs
The following Help Topic only applies to users of Globalink Power Translator Pro 
German.
German verbs in the past participle form usually take a ge- prefix. In the case of separable 
verbs, the ge- goes in between the two parts of the verb (aufstehen becomes 
aufgestanden). 
Globalink Power Translator Pro’s Specify Inflections window allows you to designate the 
separable prefix of the verb, which changes the location at which the ge- prefix is inserted in
the past participle. Changing the separable prefix also affects the split which occurs in the 
present and past tenses.
To select the Separable Prefix, use your mouse cursor to highlight the separable portion of 
the verb in the Separable Prefix section of the Specify Inflections window. As you change the
highlighted portion, you will see the changes reflected immediately in the example window.



Past Participle Inflection
The following Help Topic only applies to users of Globalink Power Translator Pro 
German.
The Past Participle Inflection portion of the Specify Inflections window allows you to override 
the defaults selected by the dictionaries with regards to the use of the ge- prefix for the past
participle of the German verb you are modifying.
If the verb is a separable verb, the program will place the ge- prefix after the separable 
portion you have specified in the Separable Prefix portion of the Specify Inflections window. 
If no prefix is found, the verb is treated as a regular verb, with the ge- prefix placed before 
the verb, with the following exceptions:
· Verbs ending in -ieren
· Verbs starting with:

· ver
· be
· ge
· ze
· e

All excepted verbs must have at least two syllables.    
To change the default behavior, click in one of the radio buttons in the Past Participle 
Inflection portion of the Specify Inflections window. If the ge- prefix is being added to a verb 
that should not take it, click in the circle to the left of Suppress ‘ge’. If the ge- prefix is not 
being added to a verb that needs it, click in the circle to the left of Force ‘ge’.



Dictionary Word Inflections
To use the Inflections tool, follow these steps:
1. Click on Inflections in the Tools menu. The Select Translator dialog box will appear. Select 
the Source/Target Language Pair for the inflections you wish to view. The Source/Target 
Language Pairs you have available will depend on the Globalink Power Translator Pro 
languages you have installed. The Inflections window will appear.
2. Make sure that the Search Toggle button is depressed, which displays the Search and Root
Word boxes in the Inflections window.
3. Type the word for which you wish to view inflections in the Search text box. 
4. If the word you have entered is a verb, you can select the tense you want to see 
conjugated. Click on one of the tenses listed in the left column. 
If you select a noun, pronoun or article, declensions can be seen for gender and number. 
Adjective forms will also include comparative and superlative forms (German adjectives 
include strong and weak forms).
5. If you want to copy a word from the Inflections window, click on the word to highlight it 
then click on the Copy button to copy the word to the Windows clipboard. You can then paste
the word to the project or to another Windows application.
To view the inflections of a word in your project file, place your cursor in or highlight the 
selected word and select Look Up Inflection from the Translate menu. The Inflections window
will appear with the inflections for the desired word displayed.



Conversation Mode
The Conversation feature gives you the ability to quickly enter and translate text between 
English and a target language. When you click on Conversation in the Translate menu, you 
will be prompted to select the Source/Target Language Pair you wish to use. After you select 
the appropriate language pair and click on OK, the Conversation dialog box will appear. 
Type the text you wish to translate in the small box at the bottom of the window. Then, click 
on the Translate button. Your translated text will appear in the large box at the top of the 
Conversation window. Once you have selected a Language Pair, you can type text in English 
or the target language. Globalink Power Translator Pro will automatically detect the correct 
source (original) language. If the program cannot determine the source language, it will ask 
you to confirm it. Once you have finished using conversation, click on the Cancel button.



Dictionary Maintenance
The Dictionary Maintenance feature allows you to activate or deactivate subject-specific 
dictionaries, create new subject-specific dictionaries, and prioritize your dictionaries in a 
manner appropriate for the text you are working with.
To access Dictionary Maintenance, select Options from the Tools menu. The Options window 
will appear. Click on the Dict. Maint. tab within the Options Window.
Before you can activate, deactivate, create, or prioritize your dictionaries, you must select 
the Source/Target Language Pair you wish to work with. To do so, click on the Select button 
in the Translation Language Pair section of the Dictionary Maintenance window. The   Select   
Translator     window will appear. Click on the Source/Target Language Pair for the dictionaries 
you wish to work with. The Source/Target Language Pairs you have available will depend on 
the language modules you have installed. Your window should show the dictionary options. If
you select Options while working on a project, the Options for that language pair will be 
displayed.
Once you have selected the Source/Target Language Pair, you can create a new Subject-
Specific dictionary, Activate/Deactivate Subject-Specific dictionaries, or change the order in 
which the dictionaries are used.
Creating Subject Specific Dictionaries 
Specifying A Shared Dictionary Location 



Creating Subject Specific Dictionaries
To add a new subject-specific dictionary, follow these steps:
1. Click on the New button in the Dictionaries section of the Dictionary Maintenance window. 
The New Dictionary window will appear. Type the name and description of the dictionary you 
wish to create.
3. Click on Local if you wish to create a new subject-specific dictionary on your local hard-
drive (it will be stored in the same location as your Globalink Power Translator Pro program 
files).
Click on Shared if you wish to create a shared (network) subject-specific dictionary.    Click on
OK to accept the information you have entered and create the new subject-specific 
dictionary. Your new dictionary will now appear in the list of available dictionaries. 
The file name associated with a user dictionary depends on the name you give the 
dictionary and the language direction that you have chosen. For example, if you add a 
Widget subject-specific dictionary for the English-Spanish Language Pair, the file name would
be ESWidget.CDS. An English-French Widget dictionary would be named EFWidget.CDS. 
Note: When you create a subject-specific dictionary for a Source/Target Language Pair, 
Globalink Power Translator Pro automatically creates the same dictionary for the opposite 
direction. For example, if you create an English-Spanish subject-specific dictionary called 
Widget, Globalink Power Translator Pro will also create the Widget subject-specific dictionary 
for Spanish-English.



Specifying A Shared Dictionary Location
Globalink Power Translator Pro can be installed and configured for use on a network. This 
allows users to share common lexicon files (all files ending in the extensions .LEX and .CDS) 
and rule files and have only the product executables and related files installed to their local 
drives. To install the program for network use, you must first install to the server and then to
local machines. Or, if the program has already been installed, and you wish to change the 
location of the shared files, skip to the section below titled Dictionary Setup. There are also 
issues specific to network use that users should be aware of. These issues are covered later 
in this section.
Server Installation:
1. Place the installation CD in the CD ROM drive.
2. Select Run from the Windows 95 Start menu. 
3. Type D:Setup in the Open text box, and click on OK to start the installation (substitute the 
correct drive letter for your CD ROM drive if it is not D).
4. Enter the correct registration information and serial number (the serial number can be 
found inside the front cover of the manual and on the CD sleeve) and click on OK to continue
the installation.
5. Indicate the network location to which you wish to install the program. This should be the 
drive from which the lexicon files will be shared. 
6. Make sure that Local is selected as the Dictionary Option. Do NOT select Microsoft Word or
WordPerfect support unless you want files copied to those word processor’s directories on 
the Server.
7. Click on OK to continue the installation. Once you have completed the server portion of 
the installation, you can install to user’s local drives.
Local Installation:
1. Follow steps one through four of the Server Installation instructions above. 
Note: Local installations must conform to your Globalink Power Translator Pro license 
agreement.
2. Indicate the local directory to which you wish to install the program files.
3. Click on Shared as the Dictionary Option in the Standard Installation dialog box, and click 
OK to continue.
4. Locate the drive and directory of the files you installed in the Server Installation. Click on 
OK to accept that location for the shared dictionaries.
5. Follow the prompts to complete the installation.
Dictionary Setup
There may be times when you want to move the shared dictionaries and have user’s 
machines point to the new dictionary location. To do so, you will need to run the Dictionary 
Setup utility from the local machines. 
To run the Dictionary Setup utility, follow these steps:
1. Select the Globalink Power Translator Pro Dictionary Setup icon from the Globalink 
program group to begin dictionary setup.
2. In the Location of Globalink Power Translator Pro text box, type the full pathway of the 
local directory where you installed Globalink Power Translator Pro (not the server 
installation), or use the Browse button to locate the file BARCSRV.EXE (this should be on the 
local machine, in the PTWIN63 directory).
3. In the Location for Shared Dictionaries text box, type the full pathway of the shared 
directory where you installed Globalink Power Translator Pro in the Server Installation, or use 
the browse button to locate any of the LEX or CDS files from that installation.
4. Click on OK to complete the Dictionary Setup.





Specifying Translation Settings
Translation options affect the way Globalink Power Translator Pro translates certain words 
and phrases. They provide greater translation flexibility and accuracy. For example, if the 
author of a document is male, you can set the Author Gender to male. You can control the 
formality level of your translation by setting the Address to formal or familiar options.
Once you have selected Options from the Tools menu, click on the Translate tab to display 
the translation options. 
Click on the Select button to select a Source/Target Language Pair. Or, if you are currently 
working on a project, selecting Options will display the Translation Options for that language 
pair (for example, if you have an English-Spanish project on screen, Options will 
automatically select the English/Spanish Translation Language Pair).

Audience
The Audience option allows you to choose the audience of the receiver of the message. The 
two choices for the option Audience are Indirect Audience (default) and Direct Audience.    
This option is only relevant for the following language pairs:    Spanish/English, Italian/English
and Portuguese/English. Effects of these options on translation are shown below:

Spanish/English 
In the Spanish/English language pair, the Option Audience is available to translate the 
Spanish personal pronoun le and the possessive adjective su.

Word Indirect Audience Direct Audience
le him you
su their your

Example Indirect Audience Direct Audience
Le visité el año pasado. I visited him last year. I visited you last year.
Quiero visitar a su madre. I want to visit their mother. I want to visit your mother.

Italian/English 
In the Italian/English language pair, the Option Audience is available to translate the 
Italian personal pronoun lei( le,la) and the possessive adjective suo.

Word Indirect Audience Direct Audience 
le her you
la her you
suo her/his your

Example Indirect Audience Direct Audience
Le inviamo i nostri saluti. We send her our regards. We send you our regards.
La chiamerò presto. I will call her soon. I will call you soon
Sua madre è molto cara. His/her mother is very kind. Your mother is very kind.



Portuguese/English 
In the Portuguese/English language pair, the Option Audience is available to translate 
the Portuguese personal pronoun lhe and the possessive adjective seu/sua.

Word Indirect Audience Direct Audience
lhe him you
seu/sua their your 

Example Indirect Audience Direct Audience
Eu lhe visitei no ano passado. I visited him last year. I 
visited you last year.
Quero visitar sua mãe. I want to visit their mother. I want to visit your mother.

Author Gender
The author is the person who wrote the document you are translating. Their gender affects 
the way certain words will be translated. The default setting for Author Gender is Masculine. 
To change the setting, click on the down arrow to the right of Author Gender and select the 
appropriate gender from the list.
If the option setting is Masculine, adjectives describing I will be masculine in gender. If the 
setting is Feminine, adjectives describing I will be feminine in gender.

Examples of Author Gender
Language English Masculine Feminine
Spanish I am tall. Yo soy alto. Yo soy alta.
French I am tall. Je suis grand. Je suis grande.
Italian I am tall. Sono alto. Sono alta.
Portuguese I am tall. Eu sou alto. Eu sou alta.
German* I am a 

teacher.
Ich bin Lehrer. Ich bin 

Lehrerin.

*Note: When translating English to German, Author Gender will affect the translation of 
predicate nominative nouns that have been marked with the ‘Both Genders’ attribute in the 
dictionary.

Address
The default setting for the form of Address is Formal. To change this setting to Familiar, 
Formal Plural, or Familiar Plural, click on the down arrow to the right of the current Address 
setting and select the appropriate form of address. The form of address affects how the 
English subject you is translated. Address settings are shown for each language in the tables
below.

Spanish
Example - cantar, to sing

Setting Form Conjugatio
n

Formal Usted canta
Familiar tú cantas
Formal Plural Ustedes cantan



Familiar Plural vosotros cantáis

French
Example - chanter, to sing

Setting Form Conjugatio
n

Formal vous chantez
Familiar tu chantes
Formal Plural vous chantez
Familiar Plural vous chantez

Italian
Example - cantare, to sing

Setting Form Conjugatio
n

Formal Lei canta
Familiar tu canti
Formal Plural Loro cantano
Familiar Plural voi cantate

German
Example - singen, to sing

Setting Form Conjugatio
n

Formal Sie singen
Familiar du singst
Formal Plural Sie singen
Familiar Plural ihr singt

Portuguese
Example - cantar, to sing

Setting Form Conjugation
Informal você canta
Formal Masculine o senhor canta
Formal Feminine a senhora canta
Informal Plural vocês cantam
Formal Masculine 
Plural

os senhores cantam

Formal Feminine 
Plural

as 
senhoras

cantam



General Application Options
There are three General Options that can be set; Sound Alert When Finished, Save Detailed 
Translation Info, and Journaling Initials. These options are described below.
Sound Alert When Finished    Place a checkmark in the box next to Sound Alert When 
Finished to have Globalink Power Translator Pro notify you when it has finished translating 
the current project. Globalink Power Translator Pro uses your computer’s default alert sound 
for the notification.
Save Detailed Translation Info    Place a checkmark in this box to have Globalink Power 
Translator Pro save information about translated sentences in your project. Saving detailed 
translation information saves time if you plan to retranslate sentences later using Interactive
Mode. Selecting this option will, however, increase the size of the associated project file.
Journaling Initials    If you would like Globalink Power Translator Pro to save your initials 
with any dictionary entry that you add or modify, enter your initials in the Journaling Initials 
text box.



Selecting Fonts
Select a string of text and click on the Font command in the Format menu to change the font
typeface, size, and style of the selected text. When you click on Font, the Font dialog box 
appears. In the Font dialog box, you can change three attributes:
Font      Use the scroll bar to search for the font typeface in the left column. Click on the 
desired font.
Style      Click in the Italic and/or Bold boxes to make the selected text italic, bold, or both. 
Click again in a box to remove the style.
Size      Select the desired font size by clicking on the appropriate number in the Size option 
column.
You can see the results of your choices in the sample at the bottom of the Font window.



Setting Paragraph Attributes

The Paragraph command, available from the Format menu, allows you to set a left and right 
indent, and specify an additional indent for the first line of each paragraph. You can also 
have Globalink Power Translator Pro remove unwanted line breaks from your imported text.
To set the left, right, and first line indents, type in the desired number of inches in the 
appropriate boxes. Or, use the up or down arrows to the left of each box to increase or 
decrease the indent amount.
Some imported text may contain carriage returns at the end of each line. If that is the case, 
Globalink Power Translator Pro will treat partial sentences as full sentences, decreasing 
translation accuracy. If you notice that Globalink Power Translator Pro is not always 
translating complete sentences, click in the Remove Extra Line Breaks box in the Paragraph 
dialog box.



Translating A Document
To translate your document, you will use one of three commands from the Translate menu; 
Document, Sentence, or Interactive.
· To translate your entire document automatically, select Document from the Translate 
menu.    
· To translate the current sentence automatically, select Sentence from the Translate menu.
· To translate the current sentence interactively, select Interactive from the Translate menu.



Translating Individual Sentences
· To translate the current sentence automatically, select Sentence from the Translate menu.
· To translate the current sentence interactively, select Interactive from the Translate menu.



Modifying Translations Using Interactive Mode
To interactively translate a sentence, follow these steps:
1. Click your mouse cursor in or highlight the sentence you wish to translate.
2. Click on Interactive in the Translate menu. Globalink Power Translator Pro automatically 
translates the selected sentence and displays the results in the Translate Interactive window.
The Translate Interactive window is split into three sections. The top section contains the 
source (original) sentence. The middle section contains the translated sentence in its current
state. The bottom section contains alternate translations for the highlighted word in the 
source (original) sentence.
3. If you click on a word in the source sentence, you will highlight that word and its 
translation in the target sentence (in the middle window). All of the possible translations for 
the highlighted word appear in the lower portion of the Translate Interactive window. To 
change a translation for a word, click on the word, then click on one of the alternate 
translations in the lower portion of the window. Since the new definition you have selected 
will need to be put into its proper form according to the original sentence (i.e. inflected 
according to tense, gender, number, etc.), the new word will not be displayed in the 
sentence until you have retranslated it.
4.    Once you have made a change, you can click on another word to make additional 
changes, click on the retranslate button to see your changes displayed in the Translate 
Interactive window, click on OK to accept your changes and return to the project window, or 
click on either the Previous Sentence/Next Sentence buttons to save or reject your changes 
and display another sentence.



Adding a Ruleset
To add a Ruleset, click on the Add Ruleset button. You will be asked to provide a name for 
your new ruleset. Type in a name and click on OK. Make a note of the name, in case you 
need to edit the ruleset later. You will be presented with a blank window in the Rule Editor.
For further information, please refer to the help topic The Rule Editor.



Opening a Ruleset
To open an existing Ruleset, click on the Edit Ruleset button. Make sure that the radio button
for Group is selected and click on the phrase User Keyed Rules in the window below the 
button. After you have clicked on User Keyed Rules, the available Rulesets for the current 
language pair will appear in the Ruleset to Edit window. If you click on a Ruleset, you will see
the text of the Ruleset displayed in the bottom portion of the Open Ruleset window. 
Once you have highlighted the Ruleset you wish to open, click on OK.
For further information, please refer to the help topic The Rule Editor.



The Rule Editor
The Rule Editor provides greater control and flexibility for adding phrases and their 
translations to Globalink Power Translator Pro than simply adding them to the dictionaries. 
Rules are used by Globalink Power Translator Pro during the translation process to determine
how source (original) sentences are analyzed, which translations are used for individual 
words and phrases in the source sentence, and how the translated sentences are 
constructed. 
The following example illustrates the advantages of entering a rule instead of a lexical 
phrase (a lexical phrase is a phrase entered into the dictionary under a single part of 
speech). Assume you are translating the sentence "The bus stopped at the bus stops," and 
you would like the source noun phrase "bus stop" translated as a particular target phrase.    
You would certainly want "bus stops" to be recognized as the plural form of the phrase "bus 
stop" and to be translated accordingly. However, you would NOT want the program to 
recognize ‘bus stopped’ as a form of the noun phrase bus stop, since ‘stopped’ is being used
as a verb in this instance.
If you add the lexical noun phrase ‘bus stop’ to the dictionary, the program will incorrectly 
translate the words ‘bus stopped’ using the target phrase that you have entered. However, 
entering ‘bus stop’ as a rule will assure that Globalink Power Translator Pro only uses the 
phrase translation for noun forms of both ‘bus’ and stop’ and will not incorrectly translate 
the phrase.
To add a Ruleset, you will use one of the Rule Templates provided in Globalink Power 
Translator Pro’s Template directory. The process is described in Chapter 6 of the Globalink 
Power Translator Pro User’s Guide.



Word Scan - Searching for Unknown Words
The Word Scan tool will find unknown words such as names, acronyms, and jargon in your 
document. Much like a spell-checker, Word Scan will allow you to ignore the unknown word 
or replace it with a word from a list of suggested alternatives. More importantly, you can 
choose to add the word to the general dictionaries or any of your active subject-specific 
dictionaries. Adding words to the dictionaries is one of the most important things you can do
to increase the accuracy of your translations.
To scan your document for unknown words, follow these steps:
1. Place your cursor at the beginning of the text in the source (upper) portion of the project 
you wish to check.
2. Select Word Scan from the Tools menu. 
3. If you have no unknown words in your document a message indicating that Word Scan is 
complete will appear. Click on OK to return to your project.
4. If Word Scan finds an unknown word, the Word Scan dialog box will appear with the 
unknown word in the Not in Dictionary box. Once an unknown word has been found, there 
are five options for that word:
Ignore - Ignores the current unknown word and searches for the next unknown word.
Ignore All - Ignores all occurrences of the current unknown word.
Change - Changes the unknown word to either a word you have typed into the Change To 
text box or a word you have selected from the alphabetical Change To word list.
Change All - Changes all occurrences of the current unknown word to either a word you have
typed into the Change To text box or a word you have selected from the alphabetical Change
To word list.
Add - Activates the Dictionary Edit window, allowing you to add the word to the Globalink 
Power Translator Pro general dictionaries or any of your active subject-specific dictionaries. 
For specific instructions on adding words to the dictionaries, please refer to Adding New 
Dictionary Entries.
Once you have added the new word to the dictionary, you can restart the Word Scan, and 
search for the next unknown word. Note: Make sure that the correct project is the active 
window before restarting Word Scan.
The Word Scan dialog box has two check boxes that can speed up your scans.
Click on Ignore UPPERCASE Words to ignore words in your document typed completely in 
uppercase letters.
Click on Ignore Words with Numbers to ignore words that contain numbers.
Note:    Unknown words are automatically treated as nouns during the translation process. 
Unknown capitalized words are treated as proper nouns. Therefore, to achieve the best 
possible translations, it is imperative to add unknown words to the dictionaries.



Project File
Before you can plunge into using the program, you need to know how Globalink Power 
Translator Pro handles files. Each time you begin working with Globalink Power Translator 
Pro, you can start in three different ways:
· Create a new project file and type text directly into Globalink Power Translator Pro (or paste
from the Windows Clipboard).
· Open a word processing file (which creates a new unnamed project).
· Open a project file that you have previously created.
The Project File
Project files contain all of the information regarding a translation project, including the 
source (original) and target (translated) text. Project files end with the extension .MTP, which
stands for Machine Translation Project. 
When you create a new project, you will be presented with an untitled project that contains 
two windows. The upper window will contain the source text. The lower window initially 
contains a copy of the source text. As you translate your project, the text in the lower 
window will be replaced by the translated text.
Creating and Opening Projects
To create a new project, select New Project from the File menu. The Select Translator dialog 
box will appear. Select the Source/Target Language Pair that you desire for your new project 
and click on OK. The source is the language you wish to translate from, and the target is the 
language you wish to translate to. 
Note: The Source/Target Language Pairs that you have available will differ depending on the
Globalink Power Translator Pro languages that you have installed.
Type the text you wish to translate in the upper (source) portion of the new project. 
To open a saved project, click on Open in the File menu. Select Project Files in the List Files 
of Type box, locate and select your file in the correct folder, and click on OK.




